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Introduction to OLI Studio 
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The enclosed materials are provided to the lessees, selected individuals and agents of OLI Systems, Inc. The 
material may not be duplicated or otherwise provided to any entity without the expressed permission of OLI 
Systems, Inc. 
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Contact Information 
Visit the Contact OLI Systems page at https://www.olisystems.com/contact to submit general inquiries, 
contact Technical Support, or search for an address and phone number. 

 

if you need to contact Support, an online request form is located at the OLI Systems Tech Support page at 
https://www.olisystems.com/contact-tech-support. Other useful links and resources are:  

• OLI Systems Support Email: oli.support@olisystems.com  
• Product Downloads: http://downloads.olisystems.com/  
• OLI Systems YouTube Channel: https://www.youtube.com/OLISystems 
• OLI Systems Wiki page: http://wiki.olisystems.com/wiki/Main_Page  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Disclaimer 
This manual was produced using the OLI Analyzer 10.0 build 1 (10.0.1). As time progresses, new data and 
refinements to existing data sets can result in values that you obtain being slightly different than what is 
presented in this manual. This is a natural progress and cannot be avoided. When large systematic changes 
to the software occur, this manual will be updated.  

  

https://www.olisystems.com/contact
https://www.olisystems.com/contact-tech-support
mailto:oli.support@olisystems.com
http://downloads.olisystems.com/
https://www.youtube.com/channel/UCRmDdUJNLrsAALfibANszMg?view_as=subscriber
http://wiki.olisystems.com/wiki/Main_Page
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Chapter I – RedOx 

RedOx is an OLI Studio option that activates a critical mechanism in electrolyte chemistry. All elements possess 

the ability to gain (reduction) or release (oxidation) electrons. When oxidation occurs, elements increase their 

oxidation state. When reduction occurs, the element decreases its oxidation state. The software’s RedOx option 

allows us to modify the oxidation state of a system so that we can better represent an actual process. 

We can tell there has been a transfer of electrons in a reaction if there is any change in the oxidation number 

between the reactants and the products.  

Example:  

𝐴𝑙(𝑠) → 𝐴𝑙(𝑎𝑞)
 3+ + 3𝑒̅ 

𝐻(𝑎𝑞)
+ + 𝑒̅ → 0.5 𝐻2(𝑔) 

_________________________ 

𝐴𝑙(𝑠) + 3𝐻(𝑎𝑞)
+ → 𝐴𝑙(𝑎𝑞)

 3+ + 1.5𝐻2(𝑔) 

Oxidation: Al lost electrons 

Reduction: H gained electrons 

In the software the RedOx reactions are turned OFF by default. The software assumes that there is not RedOx 

happening. To enable RedOx reactions, we need to click on the Re button. 

 

Transition Metals 

When the Re button is turned ON the software automatically turns on the oxidation and reduction reactions for 

the transition metals elements and some elements that belong to other metals category (see periodic table 

below), that are defined in the chemistry. 
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After completing this example, you will learn how to set up RedOx reactions in OLI Studio: Stream Analyzer 

and Corrosion Analyzer. 

Starting the Simulation 

All instructions will be represented by a check mark  

✓ To start the software, double-click the OLI Studio  icon on the desktop , which will take you to the 

OLI Studio interface where you can start creating your calculations. 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 

as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Basic RedOx calculation 

Stream Name RedOx Reactions Stream Amount Calculated Inflows (mol) 

Name Style  Formula Temperature 25 °C H2O 55.5082 

Framework AQ Pressure 1 atm Al 1 

Units sets Default (mol)     

 

✓ Add a new stream and rename it RedOx Reactions 

✓ Enter the inflows from the table below 

✓ Add a Single Point calculation  

 

✓ Select an Isothermal calculation, and change the name of this new calculation as Al RedOx 

✓ Select the Re button – it should turn light blue 
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✓ Click on the down-arrow next to the Re button, you can see that the Aluminum oxidation/reduction 

reactions have been checked automatically  

 

✓ Click on the calculate button -  

✓ Click on the Report tab and scroll down to the Element Balance table 

 

The electrochemical reaction that took place was: 

𝐴𝑙(𝑠) + 3𝐻(𝑎𝑞)
+ → 𝐴𝑙(𝑎𝑞)

 3+ + 1.5𝐻2(𝑔) 

This means that 1 mol of Al was converted to 1 mol of Al3+, and that 3 moles of molecular hydrogen (Ho) were 

created. However, the Al3+ appears all in the solid phase. This is because Al3+ hydrolyses and causes the 

formation of Al(OH)3 precipitate as shown by the reaction below. 

𝐴𝑙(𝑎𝑞)
 3+ + 3𝐻2𝑂 → 𝐴𝑙(𝑂𝐻)3 ↓ +3𝐻+ 
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No Transition Metals 

In this example, Na2S will be added to the stream. This means that we have introduced Sodium and Sulfur ions 

to the system (no transition metals). And their respective oxidation states are +1 and -2. 

✓ Add a single point calculation and rename it Na2S 

✓ Add 0.1 moles of Na2S under inflows 

✓ Select the Re button 

Note: Click on the down-arrow next to the Re button, and you can see that the Aluminum is the only 

element that has been selected to include oxidation/reduction reactions. Sodium and Sulfur are not 

turned ON by default. 

✓ Click on the calculate button 

 

✓ Click on the Report tab and scroll down to the Element Balance table 

 
 

Notice that we entered Sulfur a S-2, the software is assuming that the oxidation state for the calculation is the 

oxidation state that you entered in the inflows, which in this case would be -2. We know that Sulfur can have 
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several oxidation states, but we did not instruct the software to account for them. If you want to include the 

oxidation/reduction reactions of Sulfur, you need to turn the ON manually by clicking on it. 

 

✓ Enable Sulfur redox reaction by clicking on it 

✓ Click on the calculate button 

✓ Click on the Report tab and scroll down to the Element Balance table 

 

Notice that 8 different oxidation states for Sulfur have been enabled. The predominant oxidation state under 

these conditions is S-2. All the other ones are virtually zero.  

How do I select only oxidation states that I am interested on? 
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Selecting Specific Oxidation States 

If you want to enable specific oxidation states for Sulfur, the software gives the option to select specific oxidation 

states. 

✓ Go back to the definition tab, and then go to Chemistry > Model Options… 

 

✓ A new window opens. Select the Redox tab and expand the Sulfur subsystem. In here you can enable 

and disable all or specific oxidation states. Let’s say we want to include the following oxidation states: 

-2 and 0 only, so the window will look like the image below. 

✓ Click OK 

 

✓ Click on the calculate button 

Note: You can double check the selection by clicking on the down-arrow next to the Re button, and you can 

see that the Sulfur now shows the two selected oxidation states.  
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✓ Click on the Report tab and scroll down to the Element Balance table 

 

Notice that only the two selected oxidation states are shown in the report table, with S-2 being the most stable 

oxidation state. 
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Chapter II – Pourbaix Diagrams 

A Stability Diagram also known as Pourbaix Diagram or simply Potential vs pH diagram, maps out the possible 

stable species in an aqueous environment at different pH and potential combinations. This diagram, however, 

does not provide information of reaction rates or kinetic effects.  

Interpretation of the Stability Diagram 

Stability (Pourbaix) diagrams are a form of predominance diagrams created with two independent variables. 

They are pH on the x-axis and standard reduction potential in the y-axis. A schematic representation of the 

Pourbaix diagram for Iron in water at 25 ⁰C and 1 atm is shown in the image below.  

The basic features of a stability diagram are: 

• The dominant species is presented at any given point and not all species that would occur. 

• The bottom of the diagram refers to reduced species, i.e. Fe(s), or to the type of conditions that lead to 

reduction. 

• The top of the diagram refers to oxidized species and/or oxidizing conditions. 

• Vertical lines indicate changes in acid base chemistry independent of potential (E), e.g. Fe3+ to Fe(OH)3. 

• Horizontal lines indicate redox changes unaffected by pH, e.g. Fe to Fe2+ below pH 6. 

• The sloped lines indicate that both potential (E) and pH changes (i.e. [H+] or [OH-]) affect the redox process. 

 

Pourbaix Diagram of Iron in Water 

The stability diagrams contain a great deal of information, so it is important to describe in more detailed the 

information that is being presented, and these are: Water stability region, ORP, Natural pH, Passivity region, 

Immunity region and the Corrosion region. 
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Water Stability Region, ORP and Natural pH 

Water can act as both an oxidant agent, in which case the water is reduced to H2, and a reducing agent, in 

which water is oxidized to O2. If a chemical species is to be stable in aqueous solution, it must not react with 

the water through a redox process. In other words, the oxidation and reduction potentials of the species must 

be such that it is thermodynamically unfavorable for the species to be either oxidized or reduced by water. 

The diagonal dashed lines, represented by the letters a and b are the water reduction and water oxidation lines, 

respectively. 

 

Stability field of water 

Below the water reduction line (a): Water decomposes to form H2 gas. Above the water oxidation line (b): Water 

decomposes to form O2 gas. The region within these lines (a and b) is called the stability region of water.  

In an acid solution, the primary redox reactions are: 

Hydrogen reduction reaction: 2𝐻+ + 2𝑒̅ → 𝐻2 

Oxygen oxidation reaction: 𝑂2 + 4𝐻+ + 4𝑒̅→ 𝐻2𝑂 

In a basic solution, the primary redox reactions are: 

Hydrogen reduction reaction: 2𝐻2𝑂 + 2𝑒̅ → 𝐻2 + 𝑂𝐻− 

Oxygen oxidation reaction: 𝑂2 + 2𝐻2𝑂 + 4𝑒̅→ 4𝑂𝐻− 

In acidic solutions, the relevant reduction reaction is the reduction of H+ to H2: 

2𝐻+ + 2𝑒̅ → 𝐻2       Equation 1 

Hence, the potential for the reduction of H+ to H2 is: 

𝐸 = 0 − 0.059 log (
1

[𝐻+]
) = −0.059 𝑝𝐻 (𝑉(𝑆𝐻𝐸))  Equation 2 
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Assuming H2 gas is at 1 atm, and V(SHE) is units of volts referenced to the Standard Hydrogen Electrode.  

Equation (2) is shown in the above figure as the blue dash line, labeled a. 

When water acts as the reducing agent, in acidic solutions, the relevant half reaction is: 

4𝐻+ + 𝑂2 + 4𝑒− → 2𝐻2𝑂     Equation 3 

And the potential (E) is given by: 

𝐸 = 1.23 − 0.059 𝑝𝐻 (𝑉(𝑆𝐻𝐸))    Equation 4 

Equation 4 is shown in the above figure as the green dashed line, label b. Remember that this is a reduction 

potential, so for water to be oxidized, the species that is going to be reduced must have a reduction potential 

that is more positive than 1.23V at pH=0. This requires a fairly strong oxidizing agent.  

The values of the Natural pH and the Oxidation Reduction Potential (ORP) are superimposed on the above 

diagram. The natural pH line of the water sample is the water’s computed pH before it is adjusted using with 

acid or base to create the diagram. The ORP is represented by the red circle and indicates the initial 

electrochemical potential of the water phase. This is the value before the potential is adjusted using a 

potentiostat, for example.  

Passivity Region 

The green color represents the range of possible passivation. It is the stability field of a sparingly soluble 

compound (usually an oxide or hydroxide or salt). This compound will form a layer on the surface of the metal, 

which may protect the metal from corrosion. Having determined that a layer is formed, it is necessary to verify 

whether it is protective or not because this depends on the crystalline structure of the sparingly soluble 

compound. 

 

In the above plot, the green area contains Fe2O3 and Fe3O4 as the solid phases produced by oxidation of Fe. 

These films dramatically reduce the rate of corrosion through several mechanisms.  
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One mechanism through which passive film reduce corrosion is to act as a transport barrier. The film reduces 

the mass-transfer-limited current density of a species that must diffuse from the bulk solution to the metal 

surface in order to react. Another mechanism is that the film may block reaction sites on the surface preventing 

further corrosion. 

It has been observed that the corrosion rate is reduced substantially by the forming film even where there is not 

visible evidence of the film yet. This would be the case when only one or two monolayers have formed.  

Immunity Region 

The gray color represents the immune to corrosion region. It is the stability field of the elemental metal. Fe is 

the base metal in the above plot. 

Corrosion Region 

The light-yellow color represents the corrosion region. It is the stability field(s) of dissolved (ionic or neutral) 

metal species in which neither the metal nor passivating solids are stable. In the above plot, Fe2+ is the ionic 

species that is the most stable. 

Limitations 

Some limitations of stability diagrams include: 

• No information on corrosion kinetics is provided by these thermodynamically derived diagrams 

• The diagrams are derived for specific temperature and pressure conditions 

• In areas where a stability diagrams shows oxides to thermodynamically stable, these oxides are not 

necessary of a protective (passivating) nature. 
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Real Solution Stability Diagrams 

The diagrams generated by OLI software are not the same as those that appear in Pourbaix’s “Atlas of 

Electrochemical Equilibria in Aqueous Solutions1.” Through OLI’s electrochemical thermodynamic engine, real 

activity coefficient for virtually any aqueous chemistry can be generated at any temperature and pressure 

supported by thermodynamic engine. 

The thermodynamic engine will also calculate the required phase separation for the composition and conditions 

given and use the resulting aqueous phase for the stability diagram generation. This ensures an answer as 

close as possible to real world observed conditions. 

Building the Fe in Water Pourbaix Diagram 

After completing this example, you will learn how to set up a Pourbaix Diagram using the Stability Diagram 

tool.  

There are several steps when creating a Pourbaix diagram: 

• Environment Creation 

• Selecting the right titrants 

• Selecting the metallic surface 

• Formatting – Optional 

 

Environment Creation 

The chemical environment in which a particular metal will corrode needs to be entered before the stability 

analysis can be calculated, even is the environment is just pure water. 

There are two ways of entering the data depending on the form. If all the species are neutral, i.e. NaCl or H2S, 

then the Add Stream is sufficient. On the other hand, if the environment includes ionic species concentrations, 

i.e. Na+, Cl-, the Add Water Analysis option in needed.  

For this example, we are going to use the Add Stream option. Use the inputs and parameters from the table 

below to create the stream’s composition. Certain inputs, such as the name style, units, etc. will require further 

adjustments, and will be described as necessary.  

Stability Diagram Calculation 

Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount 55.5082 (Calculated) 

Framework  AQ Temperature 25 ⁰C 

Calculation Type Stability Diagram Pressure 1 atm 

  pH Range 0-14 

  H2O 55.5082 moles 

  Contact Surface Fe 

 

1 Pourbaix, M.1966. Atlas of electrochemical equilibria in aqueous solutions. Houston, Tex.: National Association of Corrosion Engineers 
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✓ Add a new Stream 

✓ Click on the new Stream and press <F2> to change the name to Fe-H2O System 

✓ Leave H2O as 55.5082 moles 

✓ Leave the default temperature and pressure   

✓ Go to the Add Calculation button and select Stability Diagram calculation or by selecting the Statibility 

Diagram icon in the Actions Pane. 

 

✓ Select Pourbaix Diagram as Type of Survey – Default 

✓ Click on the new icon Stability Diagram and press <F2> to change the name to Fe-H2O Pourbaix Diagram 

 

Note: Notice that two new sections appear in the Definition tab: Calculation Parameters and Contact 

Surface grids. Additionally, the Redox button Re is turned ON. 
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In the Calculation Parameters grid is where the pH titrants need to be defined. These default pH titrants 

selected by default are HCl and NaOH. You have the option to change the default titrants to your preferred 

titrants. 

In the Contact Surface grid is where the metal or alloy of interest needs to be defined. E.g. Fe, Cu, carbon 

steel, etc.  

The Redox button (Re) is turned ON for this calculation since reduction and oxidation reactions are need 

it to create the Pourbaix Diagram. This option will enable the different oxidation states of the selected metal. 

 

Selecting the right titrants 

Since the real chemistry is used to generate the diagrams, real chemistry must be used to move the pH away 

from the natural pH of the specified chemistry to sweep through the desired range of pH. Therefore, an acid 

titrant and a base titrant must be specified. By default, the software used HCl and NaOH titrants, as shown in 

the figure below. One will always have the H+ and OH- ions present with the water. HCl is chosen as the acid 

because chloride ions generally do not form complexes with many species until the system is strongly acidic. 

NaOH is used because it is the complementary base from the NaCl salt. 

The titrants can be changed by going to the specs… button. A dialog box will be displayed on which you need 

to select the Axes category and then the pH Titrant option. 

 

Default titrants HCl and NaOH are added to the defined chemistry to move along the x -axis of the stability diagram. 
The default titrants can be change by clicking on the Specs…button. 

✓ Leave the default titrants for this calculation: HCl and NaOH 

Selecting the Contact Surface 

The only requirement before the calculate button can be clicked, is to select the ‘Contact Surface’ that will be 

studied. 
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The ‘Contact Surface’ is the metallic material for which the stability is to be studied. It can be selected by using 

the drop-down list as shown in the image below. All the possible contact surfaces will be listed in the drop list.  

 

If an alloy (always the top several surfaces listed) is selected, only one contact surface can be selected. If pure 

components, i.e., Fe, Cr, Mo, are selected, several contact surfaces can be selected and will listed in series as 

shown below. 

 

Figure 1. Several pure components (elements) can be selected or only one alloy can be selected.  

 
✓ Under the Contact Surface grid type Fe 

✓ Click on the Calculate button <F9> 
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At this point all the basic inputs to create a Pourbaix Diagram have been defined. However, you can change 

these default values if you prefer.  

Diagram Ranges 

Notice that in the summary box (see above plot) the following default plotting settings have been defined: 

Potential range: -2 to 2 V vs SHE and pH range: 0-14.  

You can change these defaults in the Definition tab, by clicking on the Specs… button and then selecting 

Axes. This opens a new window. 
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Trace Species (Metal Activity) 

If the bulk chemistry does not contain any amount of the species used as the contact surface, an activity 

(𝑎𝑖 = 𝑚𝑖𝛾𝑖) must be assumed in order to find the predominant solids. In the work done by Pourbaix, and activity 

of 10-6 was used. For instance, is a contact surface of iron was used, but iron was not part of the bulk chemistry, 

there would be a singularity in the Nernst Equation for the oxidation of iron, i.e. 

𝑒 = 𝑒𝑜 −
𝑅𝑇

2𝐹
ln

𝑎𝐹𝑒

𝑚𝐹𝑒2+𝛾𝐹𝑒2+  
   Equation 5 

Where 𝑚𝐹𝑒2+𝛾𝐹𝑒2+would be equal to zero. 

By decreasing the assumed value, the areas of stability for solid films will decrease. This may be useful for 

simulating systems with high fluid velocities. 

You can change the trace default value in the Definition tab, by clicking on the Specs… button and then select 

Metal Activity.  
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Figure 2. Setting the minimum activity for trace species 

The default value for the Metal Activity is 1e-6. 

✓ To check the results, click on the Stability Diagram tab. You will see a diagram similar to the one below 

 

Diagram Editing 

The results shown in the diagram are organized in oxidation/reduction subsystems. A redox subsystem consists 

of a base species in its neutral state, say Fe, and all of its possible oxidation states, which for Fe would be Fe, 

Fe+2, Fe+3, and FeO+2. Each system contains the set of predominant solids and aqueous species that can be 

formed from the bulk chemistry and the given metal system. When more than one metal is given in the contact 

surface, one must look at all of the redox subsystems to get an idea of what stable films may form and at what 

conditions they will form.  

The edit how to display each oxidation/reduction system you can click on the “Customize” button. 
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This opens a new window. Under the Display Choices tab, you can find the following sections: 

1. Aqueous and Solids Lines: The dominant aqueous species in equilibrium with the solids can be 

turned off by selecting “No aqueous lines”. The dominant aqueous species in the regions where there 

are no solids are still displayed. 

Selecting “Only aqueous lines” will show both the aqueous species in equilibrium with solids and the 

aqueous species where there are no solids, but no solids will be displayed. 

Selecting “Superimpose lines” will show both aqueous and solids lines. 

2. Show Natural pH: The Corrosion Analyzer uses your real process fluid definition and conditions to 

calculate the natural phase separation. It also accurately predicts the pH of the bulk aqueous fluid. The 

pH at the specified conditions of the problem definition is represented by a vertical line labeled “Natural 

pH”. 

3. Show ORP: The software will place a circle that represents the oxidation reduction potential of the bulk 

solution. 

4. Display Subsystems: Here you can overlay subsystems. To overlay subsystems, simply check the 

desired subsystem. The water subsystems show both the ‘a’ and ‘b’ line. Grayed subsystems cannot 

be included until the redox option for this system is turned on in the chemistry. 

5. Shading: Only one of the selected redox sub-systems can be shaded. All others are drawn as lines. 

 

✓ Click on the Customize button, 

and make the following selections: 

o No Aqueous Lines 

o Show ORP 

 

✓ Click OK 
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It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it and name it 

as Stability Diagrams. 

Analyzing the Results 

The Pourbaix Diagram for the Fe-H2O system at 25 ⁰C and 1 atm should look like the image below: 

 

The obtained diagram is useful for assessing the corrosion behavior of iron in pure water.  

Elemental iron (gray section) is stable from -2 to -0.6 V SHE. At a potential greater than -0.6 V SHE, Fe oxidizes 

to Fe+2. If the pH is above 10, the boundary is at a lower potential for example, -0.7 V SHE at 12 pH.  

The software computes that Fe3O4 (magnetite) is stable between a pH range of ~8.3 and 12. This is also known 

as the Passive Film that protects the iron surface from active corrosion. At higher potentials, the software 

computes Fe2O3 (hematite). Hematite is the dehydrated form of Fe(OH)3 and FeOOH, two forms of rust. These 

phases provide less corrosion protection the iron surface than the magnetite. These two phases are represented 

in the plot by the green color. 

The light-yellow sections of the plot represent the dominant iron-containing species dissolved in solution. The 

species with the largest range is Fe+2. The software computes stability for this species from -0.6 V to 0.77 V 

SHE, at low pH, and it is no longer stable at pH 10. Active corrosion of the iron surface is predicted if the pH is 

between 0 and 10. The actual corrosion rate cannot be predicted from this plot, nor can the pH of the water film 

(diffusion layer) in contact with the iron surface. Therefore, the pH range of 0 to 10 is a guideline and not a 

direct prediction. 

The natural pH and the oxidation reduction potential (ORP) of water, which is represented by the red circle, are 

showing that when placing Fe in pure water at 25 ⁰C and 1 atm. The point at which the natural pH and the ORP 

intersects (7 pH, 0.4 V SHE) indicates that Fe2O3 (hematite) is the most stable species that forms. 

Additionally, notice that the oxidation of iron can be coupled with the reduction of water because water reduction 

line (line a) lies above the lines that represent the oxidation of iron. Therefore, corrosion of iron can occur with 

the evolution of hydrogen and formation of soluble iron-containing ions e.g. Fe2+. 
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Modeling the Effects of Hydrogen Sulfide on Corrosion 

The H2S (S-2) forms a relatively insoluble precipitate with Fe+2. This precipitate has the potential to cover the 
metal surface and enhance the pH region where iron is protected from the water. We will model this using the 
Stability Diagram tool. 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 

Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 

Name Style Display Formula Temperature 25 ⁰C 

Unit Set Metric, Batch, Moles Pressure 1 atm 

Framework  AQ pH Range 0-14 (Default) 

Calculation Type Stability Diagram H2O 55.5082 moles 

Contact Surface Fe H2S 1e-4 moles 

 
✓ Under the Fe-H2O System add a new Stability Diagram calculation. Go to the Add Calculation button and 

select Stability Diagram calculation or by selecting the Stability Diagram icon in the Actions Pane. 

✓ Select Pourbaix Diagram as Type of Survey – Default 

✓ Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O-H2S System 

✓ Enter the composition, temperature and pressure of the stream given in the table above. Add 1e-4 moles 

of H2S as an inflow. 

✓ Under the Contact Surface grid type Fe 

The screen should look like the image below after all the inputs and definitions have been entered: 
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Note: By default, only the transition metals are turned ON. The different oxidation states of elements that are 
not transition metals are not turned on automatically. You need to turn them ON manually. Just as it was 
discussed in the RedOx section above. You can also select specific oxidation states for Sulfur in Chemistry > 
Model Options > Redox. 

✓ Go to the Redox button (Re), and click on the drop-down arrow 

✓ Select Sulfur. This will turn the oxidation states of sulfur ON 

 

✓ We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 

the same file created in the previous example named Stability Diagrams. 

Analyzing the Results 
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Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-
H2O-H2S system at 25 ⁰C and 1 atm. 
 
Inspection of the diagram reveals a profound effect of H2S on the corrosion of iron. New stability fields of FeS 
and FeS2 are observed. Elemental iron is found to be in equilibrium with FeS over for pH values ranging from 
ca. 6.0 to 12.5.  

Since the Fe/FeS equilibrium line lies below the H+ reduction line (a), a process consisting of the reduction of 
H+ to H0 and oxidation of Fe to FeS is likely to occur in de-aerated environments. FeS forms a passive film and 
offers some protection against corrosion.  

In fact, the protection due to the formation of FeS is possible over a much wider pH range than that due to the 

formation of Fe3O4 (magnetite) in the absence of H2S. This has important implications for corrosion in refinery 

installations, where H2S is frequently present.  
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Chapter III – Corrosion Rates and Polarization Curves 

In this chapter we are going to introduce the theory behind the corrosion rate calculations and polarization 

curves calculated by the software. Then we will jump to hands on exercises. 

First, let’s start with some corrosion/electrochemistry definitions to understand how corrosion rates and 

polarization curves are calculated in the software.  

Polarization 

Polarization may be defined the shift in electrode potential which results from the effects of current flow with 

respect to the zero current flow potential. Potential is a thermodynamic variable that can be measured against 

a suitable reference electrode and has units of volts. 

Polarization,  , is the potential change, 𝑉 − 𝐸, from the equilibrium half-cell electrode potential, 𝐸. Anodic 

polarization results in   being positive, and cathodic polarization results in  being negative. Both 𝑉 and 𝐸 are 

also potentials.  

The potentials are measured at the metal/fluid interface. Since metals are very conductive, the measurement 

point on the metal side can be some distance away without needing a correction, so a wire lead is simply 

attached to the metal. A reference electrode is used to measure potential in the electrolyte. It must be place at 

some distance away from the metal to avoid errors due to transport gradients. However, an aqueous electrolyte 

has a finite conductivity so there will be an IR drop between the location of the measurement device and the 

metal surface.   

Reference Electrodes 

All voltages in electrolytes are measured with respect to a known chemical reaction, the hydrogen reaction, and 

the standard hydrogen electrode is used. In practice, the hydrogen electrode is not always useful. Other 

reference electrodes can be used if they can be limited to a single reversible reaction. When selecting a 

reference electrode, it must at least have a common ion with one in the electrolyte, and its concentration should 

not be vanishingly small. 

A common reference electrode is the Cu/CuSO4 which is often used to measure potentials in soil environments 

such a storage tank bottoms or buried pipelines. A value of 0.337V must be added to a reading from a 

Cu/CuSO4 to get the equivalent reading to hydrogen electrode. 

In sea water, the Ag/AgCl electrode is often used. It is picked because of the common ion, Cl-. 

Reaction Rates 

To predict corrosion rate is to predict the rate at which a number of oxidation/reduction reactions will proceed 

including the metal dissolution reaction. An oxidation/reduction reaction will either consume or produce 

electrons and must be coupled to another reaction such that the net production of electrons is equal to zero. 

Tafel behavior 

The rate at which an electrochemical reaction takes place can often be represented by the Butler-Volmer 

equation: 
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𝑖 = 𝑖𝑜 [exp (
𝛼𝑎𝐹

𝑅𝑇


𝑠
) − exp (−

𝛼𝑐𝐹

𝑅𝑇


𝑠
)]   Equation 6 

Where 𝑖𝑜 is the exchange current density, 𝐹 is the Faraday’s constant (96485 equiv/Coulomb), 𝛼𝑎 and 𝛼𝑐 are 

kinetic parameters, R is the gas constant and T is the temperature. 𝑖𝑜 is a function of concentration at the 

electrode (corroding material) surface and has parameters that must be fit using experimental data. It can be 

shown that Butler-Volmer type equations can be derived from many simple reactions involving single electron 

transfers described by Arrhenius type equations. Empirically, it has been shown that the above equation or one 

of its modifications from the following section, describe nearly all reactions associated with corrosion. Reactions 

that follow equation 6 are often said to have Tafel kinetics.  

Mass-Transfer Limitations 

The reactant O2 in the equation below 

𝑂2 + 4𝐻+ + 4𝑒− → 2𝐻2𝑂      Equation 7 

must come from the bulk fluid. It is therefore subject to mass-transfer limitations since it cannot react until it is 

at the metal/fluid interface. For a given fluid velocity and concentration of O2, a maximum rate of transport of O2 

can be calculated from solving the convective diffusion equation: 

𝜕𝐶𝐴

𝜕𝑡
+ (𝑣∗ ∙ ∇𝐶𝐴) = 𝐷𝐴𝐵∇2𝐶𝐴     Equation 8 

where 𝐶𝐴 refers to the concentration of O2 and 𝐷𝐴𝐵 is the diffusivity of O2 in water, subject to the boundary 

conditions 

𝐶𝐴 = {
0,        𝑎𝑡 𝑧 = 0;
𝐶∞     𝑎𝑡 𝑧 = 𝛿

       Equation 9 

where 𝛿 is the length where complete mixing occurs, usually just outside the turbulent boundary layer point. 

The calculated maximum mass-transfer rate can be converted to a current density, 𝑖𝑙𝑖𝑚.𝑂2
, with Faraday’s 

constant. Then, equation 6 can be rewritten as: 

𝑖𝑂2
= 𝑖𝑜 [exp (

𝛼𝑎𝐹

𝑅𝑇


𝑠
) −

1
𝑖𝑜

𝑖𝑙𝑖𝑚.𝑂2
+exp

𝛼𝑐𝐹

𝑅𝑇
𝑠

]    Equation 10 

where the term corresponding to the consumption of O2 is limited to no more than 𝑖𝑙𝑖𝑚.𝑂2
. 

The figure below, illustrates how a reaction that has a mass-transfer limitation behaves as the rate goes from 

activation control (Tafel kinetics) to mass-transfer limitation.  
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Reaction exhibiting mass-transfer-limited behavior 

Homogeneous Reaction Limitations 

H2CO3 can react at the metal surface to form H2 and HCO3
- and liberating one electron. In this case, the rate at 

which H2CO3 can react is not limited by diffusion, but by how fast it can be formed after it is consumed. 

Mixed Potentials 

In a corroding surface, several reactions are occurring simultaneously, and the observed potential is that due 

to how all of the reactions balance the electrons.  

Net Current 

Since the software is valid only within the constraints of aqueous systems, the polarization curves will be 

bounded by water decomposition reactions. At sufficiently positive potential, the oxygen evolution reaction will 

occur: 

2𝐻2𝑂 → 𝑂2 + 4𝐻+ + 4𝑒−      Equation 11 

and at sufficiently negative potentials the hydrogen reaction occurs 

2𝐻2𝑂 → 𝐻2 + 2𝑂𝐻− − 2𝑒−     Equation 12 

The rates for the two reactions (10 and 11) can be expressed using equations of the form of (6), or for mass-

transfer-limited reactions (7), which are summed to give the net current according to: 

𝑖𝑛𝑒𝑡 =  ∑ 𝑖𝑜,𝑗𝑗 [exp (
𝛼𝑎,𝑗𝐹

𝑅𝑇


𝑠,𝑗
) − exp (−

𝛼𝑐,𝑗𝐹

𝑅𝑇


𝑠,𝑗
)] + ∑ 𝑖𝑜,𝑘𝑘 [exp (

𝛼𝑎,𝑘𝐹

𝑅𝑇


𝑠,𝑘
) −

1
𝑖𝑜,𝑘

𝑖𝑙𝑖𝑚.𝑘
+exp

𝛼𝑐,𝑘𝐹

𝑅𝑇
𝑠,𝑘

]  Equation 13 

for j reactions without mass-transfer limitations, and k reactions with mass-transfer limitations. The hydrogen 

and oxygen evolution reactions and the net current are plotted on a log scale as E vs |i| in Figure the below, 

which is also commonly called a polarization curve.  
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Basic polarization curve of water decomposition.  

Open Circuit Potential 

In the figure above, notice that at a potential of 0.322V, the net current approaches a value of zero. The zero 

point indicates the open circuit potential, or corrosion potential, but the rates of the reactions are not necessarily 

zero. This is the point where the sum of the rates of all of the reactions at the metal/fluid interface is equal to 

zero. This point is easily determined experimentally.  

Adding Reactions 

If iron was place in the water, a third reaction becomes possible, i.e. the dissolution of iron: 

𝐹𝑒 → 𝐹𝑒+2 − 2𝑒−     Equation 14 

Adding a line for reaction (13) and adjusting the net current, equation (12), to include the new reaction, produced 

the plot in Figure 13. 

 

Basic polarization curve with water decomposition and (Fe) corrosion reaction 
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The open circuit potential has been shifted increasing the rate of hydrogen evolution and decreasing the rate 

of oxygen evolution. The value of the current density at the new open circuit potential should not be confused 

with the exchange current density, 𝑖𝑜, the simultaneous forward and backward rate of a single reaction at steady 

state. Exchange current is the rate of either oxidation or reduction at the equilibrium electrode. It is expressed 

as a current. It is also technically a misnomer, since there is no net current flowing.  

It should be noted that the flattening of the rate of the dissolution of Fe (vertical line) is not necessarily a mass-

transfer effect but does reflect the fact that the metal passivates. 

Adding H2CO3 to the fluid in contact with the metal adds 2 more reactions 

2𝐻2𝐶𝑂3 → 𝐻2 + 2𝐻𝐶𝑂3
− − 2𝑒−     Equation 15 

2𝐻+ → 𝐻2 − 2𝑒−      Equation 16 

Both of these reactions will have mass transfer effect limitations.  

The below figure shows the addition of reactions (15) and (16) to the model. The addition pushes up the rate of 

corrosion and moves the corrosion potential towards a more anodic value. As more components are added, 

more reactions influencing corrosion may be added to the mixed potential expression. For instance, Figure 5, 

shows the addition of H2S to the system at conditions of saturation and higher temperature. Also note that the 

changes in conditions affect the corrosion (anodic) polarization shape.  

 

Polarization curve with water decomposition, corrosion reaction and two mass-transfer-limited reactions 

Not all corrosion processes proceed by simultaneous reactions on the same surface. When two dissimilar 

metals are in electrical contact with each other, an electrochemical cell can be established through the process 

fluid. Then one surface acts as an anode, where the metal corrodes at a higher rate, supplying electrons to the 

other metal which will now corrode at a lower rate. The reactions on both surfaces remain the same, but at a 

steady state, neither metal is at its corrosion potential. Sometimes, this effect is purposely used to protect a 

metal. For instance, zinc and aluminum are used as sacrificial anodes to protect iron or steel hull of ships. 
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Net current curve 

Of all the curves plotted by OLI Studio: Corrosion Analyzer, only the ‘net current’ is experimentally measurable. 

However, many of the underlying reactions can be seen in the curve. At either end are the water decomposition 

reactions and sometimes a transition to the passive state for the anodic reaction may be observed. When mass-

transfer limitations are reached for different reaction, they may be seen as small ‘plateaus’ in the curve.  

Mass-Transfer Limitations 

Figure 15 has a region of the curve circled where a mass-transferred limitation in one reaction influences the 

next current density. These regions are often called a plateau because on a log scale, there is very visible 

change in current density within a relatively large region of potential. One must change potential sufficiently so 

that another reaction rate can ‘catch up’ to the reaction that is mass-transfer-limited.  

 

Active-to-Passive Transition 

In the figure below, the point labeled Epp denotates the location of the active-to-passive transition. It is the point 

where increasing potential no longer results in increasing corrosion density. It is cause by the formation of 

passivating films on the metal surface that either blocks reaction sites by tightly bonding to the metal, or by 

retarding diffusion of corrosive species such as oxygen. 

 

Figure 3. Basic polarization curve. At a potential given by Epp, the metal will begin to express passive behavior.  

The type of curve predicted by OLI Studio: Corrosion Analyzer, in the active-to-passive region is one that can 

only be produced with a potentiostatic controlled experiment or a galvanostatic controlled experiment. In a 

potentiostatic experiment, the potential (or more correctly polarization) is varied and current is measured. In a 

galvanostatic experiment the current is varied, and the potential is measured. Figure 4 shows a net current 

curve that would be produced by a galvanostatic experimental technique. When plotted, the passive region 

would be skipped all-together, and only the active and trans-passive regions would appear. However, if the 

experiment was reversed in the trans-passive region, the passive region could be seen, but the return to the 

active region would be missed. This is the same system/curve shown in Figure 4. 
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Figure 4. Basic polarization curve demonstrating a galvanostatic sweep. The arrows indicate how the potential is 
changing as one moves along the line.  

The point at which the active/passive transition is made can be seen by the potential “jump” made by the small 

increase in current density at the point labeled “Epp.” The passive current density and the transition from passive 

to transpassive behavior is seen with the current density sweep is reversed and slowly brought back to zero. 

What is missed, is the transition region from the active corrosion rate and the passive corrosion rate. 

Transpassive Region 

As the potential is increased to a high anodic value, other anodic reactions may become substantial enough to 

affect the net current. The transpassive region is the section of the curve anodic to the corrosion potential where 

the current density increases again after having been flat for a range of potential. In the case of the curve plotted 

in Figure 5, the reaction is the oxygen evolution reaction for the breakdown of water. In other words, the water 

stability limit is reached. 

 

Figure 5. Polarization curves for carbon steel in an environment saturated with CO2 and H2S.  
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pH Changes at the Interface 

It is commonly observed that the pH at the metal surface increases from the bulk pH. The partial processes 

shown in the polarization curves explain the behavior. 

Figure 5 shows three reactions where hydrogen ions are consumed at the metal surface, and none are 

produced. As the mass transfer limitation is approached, the pH will rise because fresh hydrogen ions will not 

be able to diffuse fast enough to replace what is lost through the partial processes. 

 

Fluid Dynamics 

As seen so far, the corrosive species must come from the bulk aqueous phase before it can react at the metal 

surface. Equation 8 shows that the fluid velocity plays an important role in determining the rate at which a 

species that influences corrosion can get to the surface. Therefore, understanding how fluid dynamics affects 

corrosion is important. 

Examining equation 8 shows that a known fluid velocity profile is needed, or simultaneous solution of Navier-

Stokes, mass conservation, and equation 8 is needed. Since it is computationally expensive to solve all three 

systems of equations, OLI uses known solutions for certain velocity profiles to determine 𝑖𝑙𝑖𝑚. These are:  

• Static - 𝑣 ≈ 0 

• Pipe flow 

• Rotating disk 

• Rotating cylinder 

• Complete agitation – a special limiting case where no mass-transfer-limitations 

• Defined shear stress 

• Approximate multiphase flow 

 

Figure 6. Net current density curve for the same system at three different velocities 

Figure 6 shows a system where only the velocity has been varied. The mass-transfer-limited plateau increases 

with increasing velocity indicating the greater availability of species due to increased mass transport.  
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A Basic General Corrosion Rate Calculation  

A brief introduction to the corrosion rate tool will be shown in the example below. As we go through the example, 

the basic definitions, functionalities and reporting for the Corrosion rate tool will be introduced.  

Corrosion rate of an oxygenated 0.1 m NaCl solution 

Starting the Simulation 

✓ To start the software, double-click the OLI Studio icon on the desktop, which will take you to 

the OLI Studio interface where you can start creating your calculations. 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 

as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Corrosion Rate Calculation 

Calculation Settings Stream Composition and Conditions 

Stream Name CR of carbon steel Stream Amount Calculated 

Name Style Display Formula Temperature 25 ⁰C 

Unit Set Metric, Batch, Moles Pressure 1 atm 

Framework  AQ H2O 55.5082 moles 

Calculation Type Corrosion Rates O2 2.5e-4 moles 

Contact Surface Carbon Steel G10100 (generic) NaCl 0.1 moles 

 

✓ Add a new Stream 

✓ Click on the new Stream and press <F2> to change the name to CR of carbon steel 

✓ Select the AQ thermodynamic Framework 

✓ Click on the Names Manager Icon and select the Formula option 

✓ Click on the Units Manager Icon, and select Metric, Batch, Moles 

✓ Enter the composition, temperature and pressure of the stream given in the table above 

✓ Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add 

Corrosion Rates icon in the Actions Pane. Your screen should look like the image below. 
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Note: By default, the software has selected Carbon steel G10100 (generic) as the default contact surface to 
perform the corrosion rates on. You can click on the white space of the Carbon steel G10100 (generic) name, 
and it will show a drop-down arrow. You can then click on the dropdown arrow, and you will be able to see and 
select any alloy present in the Alloy database. 

 

Additionally, the Calculation Parameters grid shows two options: (1) Flow Type and (2) Effect of FeCO3 /FeS 
scales on corrosion rates. 

By default, the software selects Static as Flow Type. There are 7 options for Flow Type, and a brief description 
of the first five options will be given below. 

 
Static 
The solution is not flowing in this calculation.  

Pipe Flow 
The fluid is flowing through a pipe. The pipe diameter and flow velocity must be defined. The default pipe 
diameter is 0.1 meters and the default flow velocity is 2 m/s.  

Rotating disk  
This reproduces a type of experiment that is used quite frequently in the laboratory. A disk is rotated to bring 
fluid to the surface of the electrode in a predictable manner. The diameter of the disk is specified as well as the 
revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000 RPM.  

Rotating Cylinder  
This reproduces a type of experiment that is used quite frequently in the laboratory. A cylindrical rotor is rotated 

to bring fluid to the surface of the electrode in a predictable manner. The diameter of the rotor is specified as 

well as the revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000 

RPM.  

Complete Agitation  
In this calculation, the liquid phase is completely agitated, and no mass transfer limitations apply. 
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✓ Leave the default alloy Carbon steel G10100 (generic) as the contact surface 
✓ Go to the Survey by option and select Single Point Rate. This option will allow you to calculate the 

corrosion rate at the temperature and pressure specified. 

 

Note: You can also study the effect of other variables such as temperature, pressure, (chemical species) 
composition, pH, pipe flow, etc. on the corrosion rate. The effect of these variables can be set up as a survey 
calculation. In the upcoming corrosion rate examples, survey calculations to study corrosion rates will be shown 
in more detail. 

A brief description of the most common survey types for studying corrosion rates are given below.  

pH Survey – This calculation is similar to the pH survey available in OLI Studio: Stream Analyzer. The 
specification requires a titrant acid and base to change the pH.  

Temperature Survey – The default range is from 25-100 ⁰C. Any range may be used by changing the Range 
option. The user should consider that some points in the survey may not converge due to phase changes (e.g., 
boiling off of aqueous liquids).  

Composition Survey – The composition of a chemical compound, for example NaCl, can be varied to study its 
effects on corrosion rates. The range of the chemical compound defaults from 0 to 1 mole with an increment of 
0.1 moles. This range can be changed via the Range option.  

Care should be taken when adding salts that can form hydrates (e.g., CaCl2.6H2O). When these hydrated salts 
begin to precipitate from solution, large amounts of water may be complexed with the crystal. The solution may 
dehydrate, and non-convergence may be the result.  

Pressure Survey – The pressure of the system can also be varied. The default range can be changed via the 
Range option. Care should be taken when working at very low pressures since the solution may inadvertently 
boil off the liquid and non-convergence may result.  

Flow Velocity Survey – In systems that are flowing, the flowrate of the stream can be varied. 

 

✓ Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
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✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. Create a new file and 
name it: Corrosion Rates. 

 

Analyzing the Results 

✓ Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 

corrosion rate and pH. 

 

 

✓ Click on the View Data button to see the results in tabulated form. 

 

The predicted corrosion rate of carbon steel at 25 ⁰C and 1 atm is 0.13 mm/year when exposed to an 

oxygenated 0.1 m NaCl solution. It is important to highlight that this predicted corrosion rate is the corrosion 

rate once the system has reached a steady state.  
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✓ Click on the Localized Corr. Rate tab ( ). This tab displays a plot showing the results 

of three different calculated data: 

• Corrosion Potential (red dot) 

• Repassivation Potential (yellow triangle) 

• Maximum Pit Current Density (blue square) 

 

✓ Click on the View Data button to see the results in tabulated form. 

 

Notice that in this case, the corrosion potential has a higher value than the repassivation potential. This 

indicates that carbon steel at 25 ⁰C and 1 atm when exposed to an oxygenated 0.1 m NaCl solution will 

likely suffer localized corrosion (pitting or crevice corrosion). The maximum pit current density gives the 

worst-case pitting rate for these conditions.  
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✓ Now, click on the Polarization Curve tab ( ). This tab displays a plot showing the 

calculated polarization curve of carbon steel. 

 

 

The net polarization curve is given by the red curve. This red curve is obtained by adding up all the currents 

of the half reactions at a given potential. The corrosion potential is calculated by applying the mixed potential 

theory, and it is represented by this red triangle. Once the corrosion potential is obtained, the corrosion 

current density also is computed and subsequently the corrosion rate. 

  



 

think simulation | getting the chemistry right 42 

 

Gas condensate corrosion – Understanding the Polarization Curve 

Condensed overhead gas and mitigation strategies 

An alkanolamine gas sweetening plant has corrosion problems in the condensed overhead gas. 

Diethanolamine is used to neutralize an acid gas containing carbon dioxide (CO2) and hydrogen sulfide (H2S). 

The diethanolamine is regenerated and the acid gases are driven off in a stripper. The off gas from this stripper 

is saturated with water vapor. As these gases cool, they will condense. This condensate can be very corrosive. 

The plant’s service life can be shortened considerably due to these condensed acid gases. 

In this example, you will calculate the gas dew point temperature, remove the condensed aqueous phase and 

perform a Corrosion Rate calculation with the condensed water. Lastly, you will consider mitigation strategies 

for the pipes.  

You are introducing fluid velocity and liquid condensation into the calculation. The software uses a diffusion 

layer model to compute mass transfer to and from corroding surfaces. Higher rates produce thinner layers, 

resulting in faster mass transfer rates, and thus higher corrosion rates. The liquid condensation point is 

straightforward; it calculates the temperature (or pressure) where the first liquid drop forms. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 

as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Corrosion Rate Calculation 

Calculation Settings Stream Composition and Conditions 

Stream Name Gas condensate Stream Amount 1e5 moles 

Name Style Display Formula Temperature 38 ⁰C 

Unit Set Metric, Batch, Mole Fraction Pressure 1.2 atm 

Framework  AQ H2O Calculated (mole%) 

Calculation Type Corrosion Rates CO2 77.4 

Survey Single Point Rate N2 0.02 

Flow Type Pipe Flow H2S 16.6 

Pipe Diameter 10  cm CH4 0.5 

Pipe Flow Velocity 2 m/s C2H6 0.03 

Contact Surface Carbon Steel G10100 (generic) C3H8 0.03 

 

✓ Add a new Stream 

✓ Click on the new Stream and press <F2> to change the name to Gas Condensate 

✓ Select the AQ thermodynamic Framework 

✓ Click on the Names Manager Icon and select the Formula option 

✓ Click on the Units Manager Icon, and select Metric, Batch, Mole Fraction 

✓ Enter the composition, temperature and pressure of the stream given in the table above 

✓ Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add 

Corrosion Rates icon in the Actions Pane.  

✓ Go to the Survey by option and select Single Point Rate. Change the name to Gas Cond. Dew Point. 
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✓ Change the Flow Type from Static to Pipe Flow. 

✓ Specify the Pipe Diameter = 10 cm and the Pipe Flow Velocity = 2 m/s. 

✓ Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

 

Your screen should look like the image below. 

 

 

Now that the gas condensate stream is created, the next task is to isolate the condensed water at the dew point 

temperature. 

 

✓ Click on the Specs button. This will open a new window 

✓ Under the Category section, select Calculation Type 

✓ Change the Type of Calculation from Isothermal to Dew Point. Make sure that radio button for temperature 

is selected since we are going to calculate the Dew Point temperature for this example. Then click OK. 

✓ Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 

the same file created in the previous example named Corrosion Rates.  
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Analyzing the Results 

✓ Click on the General Corr. Rate tab ( ). 

✓ Click on the View Data button to see the results in tabulated form. 

 

✓ Notice that the calculated dew temperature is 37.6⁰C, corrosion rate is 0.7 mm/year, and the dew point pH 

is 3.9. To further interpret the results of this calculation, we are going to study the polarization curve.  

✓ Click on the Polarization Curve tab ( ). Before interpreting this plot, we will format it for 

easy viewing. 

✓ Click on the Options button. This will open a new window.  

 

✓ Under the Category section select X axis.  Change the Minimum to 1e-6 and Maximum to 1e6. 

✓ Now, select Y axis.  Change the Minimum to -1.5 and Maximum to 1.5. Then click OK. 

✓ Click on the Variables button. This will open a new window.  

 

✓ Remove the following variables by unchecking them. See image below. Then Click OK. 
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✓ Your polarization curve should look like the image below. 

 
You can click and drag the legend of the polarization curve to your desired position.  

This is a measured potential vs. current density plot. The anodic portion (green curve) is the carbon steel. There 

are cathodic reactions. The sum of the cathodic currents adds up to the anode curve at a single point: The 

corrosion potential (represented by the inverted red triangle ▼) with a value of -0.43 V vs SHE. At the corrosion 

potential, the anodic and cathodic currents are equal, and this value is also known as the icorr. For this example, 

icorr=0.61 A/m2. 

Notice that the cathodic reaction that contributes the most to corrosion is H2CO3 (light green line). The next 

contributors are H2S (orange line) and HS-1(blue line) equally. After that is H+ (turquoise line). Water reduction 

(light blue line), contributes the least to corrosion. 

 

Mitigation Strategies 

There are several mitigating solutions to this corrosion problem. 

One is adding insulation to prevent temperature drops. The dew point is very close to the overhead gas 

temperature so this may not be a suitable option. Adding heat to keep the temperature above the dew point is 

usually considered along with insulation. 

Changing the chemistry to change the partial oxidation and reduction processes is also an option.  

Changing alloys could mitigate the corrosion problems as well.  

We will explore the change of chemistry and change of alloys for this example. 
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Adjusting the solution chemistry 

The condensate pH is approximately 3.9. We can try to add a base to increase the pH. In this section, we will 

add Diethanolamine to raise the pH to 7.5. 

Single Point– Set pH Calculation 

 
✓ Click on the ‘Gas Condensate’ stream and go to the Add Calculation button and select Single Point 

calculation or by selecting the Add Single Point icon in the Actions Pane.  

✓ Change the name to DEA using the <F2> key.  

✓ Add DEA in the inflows grid. (It should have changed to the formula name: HN(C2H4OH)2 

✓ Go to the Type of Calculation option and select Set pH 

✓ Change the Target pH to 7.5 

✓ Click on the drop-down arrow for the pH Base Titrant and select DEA (or HN(C2H4OH)2) 
 
We have set up the calculation to adjust the amount of DEA to match the target value of pH=7.5. 
 
Your screen should look like the image below. 

 
 

✓ Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 
the same file created in the previous example named Corrosion Rates.  
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Analyzing the Results 

✓ Check the summary box to analyze the results. 

 

The pH is set to 7.5 and the inflow of DEA to the total gas is approximately 5.97e-4 mole%. 

The DEA concentration in the condensing water and the amount remaining in the vapor phase can both be 

viewed in the Report tab. 

✓ Click on the Report Tab and go to the Total and Phase Flows and Species Output tables 
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Recalculating the corrosion rate with DEA 

We now can recalculate the corrosion rate with DEA in the stream. This represents some DEA entrained in the 

vapor phase in the gas that leaves the regenerator. 

✓ Right click on the DEA Stream, and select the option Add As Stream 

 

✓ This will open a new window 
✓ Change the name to Gas Cond. Dew Point DEA and click OK 

 

 
 

✓ Click on the Gas Cond, Dew Point DEA stream 
✓ Add a corrosion rate calculation 
✓ Select single point rate 
✓ Change Flow Type to Pipe Flow (Leave the default values of pipe diameter= 10 cm and pipe flow velocity 

of 2 m/s) 
✓ Change the name to Gas Cond. Dew Point DEA  
✓ Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

Your screen should look like the image below. 
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✓ Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 
the same file created in the previous example named Corrosion Rates. 

 

 

Analyzing the Results 

✓ Click on the General Corr. Rate tab ( ). 

✓ Click on the View Data button to see the results in tabulated form. 

 

Notice that the corrosion rate has decreased from 0.7 mm/year to 0.48 mm year. The pH is 7.5 - the target 

pH. Based on these results neutralizing the pH had a partial effect on corrosion reduction.  

 

Changing the Alloy 

Since treating the acid gas with a base is probably not a good idea for metal hydroxides, perhaps we can 

change the alloy. We will add a new corrosion rates calculation and test different alloys. 
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13%Cr Stainless Steel 

 
1. Copy ‘Gas Cond. Corrosion’ corrosion calculation, and paste it under the stream ‘Gas Condensate’ 

 
2. Change the name to Gas Cond. Corrosion - 13Cr using the <F2> key.  

 
3. Change the contact surface to 13%Cr stainless steel 

Your screen should look like the image below. 

 

 
4. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

 
5. It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 

the same file created in the previous example named Corrosion Rates. 

 

Analyzing the Results 

i. Click on the Report tab to see the results. (You may need to use the ◄► buttons to move the tabs and 

find the Report tab). 

ii. Go to the Calculated Rates table 
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The corrosion rate of 13%Cr is one order of magnitude lower when compared to the corrosion rate for 

Carbon Steel, i.e.  at 0.06 mm/year for 13%Cr vs 0.7 mm/year for Carbon Steel. This is consistent with the 

use of 13% Cr to protect against CO2 corrosion. 

iii. Click on the Polarization Curve tab ( ). 

iv. Click on the Variables button. This will open a new window.  

 

v. Remove the following variables by unchecking them. See image below. Then Click OK. 

 

vi. The polarization curve (after some layout modifications) should look like the image below. 

 
The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select  

the option Alloy Layout Changes to modify the appearance of your plot.  

The corrosion potential of 13%Cr is -0.31 V vs SHE and the corresponding corrosion current icorr=0.06 A/m2. 

The icorr for Carbon Steel was 0.61 A/m2, this means that 13%Cr is 10x more resistant to corrosion under the 

same conditions.  
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Stainless Steel 304 

 
✓ Copy ‘Gas Cond. Corrosion’ corrosion calculation, and paste it under the stream ‘Gas Condensate’ 
✓ Change the name to Gas Cond. Corrosion - 13Cr using the <F2> key.  
✓ Change the contact surface to Stainless Steel 304 

 
Your screen should look like the image below. 
 

 
 

✓ Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
✓ It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under 

the same file created in the previous example named Corrosion Rates. 
 

Analyzing the Results 
 

✓ Click on the Report tab to see the results. (You may need to use the ◄► buttons to move the tabs and 
find the Report tab). 

✓ Go to the Calculated Rates table 
 

 
 

The corrosion rate of 304 SS is now 0.0036 mm/year. This is a negligible value. 
 
✓ Click on the Polarization Curve tab ( ). 
✓ Click on the Variables button. This will open a new window.  
✓ Remove the following variables by unchecking them. See image below. Then Click OK. 
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The polarization curve (after some layout modifications) should look like the image below. 

 
The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select  

the option Alloy Layout Changes to modify the appearance of your plot.  

The corrosion potential of SS304 is -0.17 V vs SHE and the corresponding corrosion current icorr=3.3e-3 A/m2. 
With this low corrosion current density, sour gas regeneration can be remedied using a higher-grade alloy such 
as SS304.    
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Chapter IV – Repassivation Potential and Localized Corrosion 

The OLI Studio: Corrosion Analyzer, includes the ability to predict the repassivation potential and a peak current 

density for active pits. The repassivation potential is important for corrosion analysis because it indicates how 

well an alloy can “repassivate” active pits. 

Repassivation Potential 

The repassivation Potential (Erp) also called the protection potential. The repassivation potential is a measure 

of the tendency of an alloy to undergo localized corrosion in a given environments. The underlying justification 

for the use of Erp is the fact that, for engineering applications, only the fate of stable pits or crevices is important. 

Pits that nucleate, but do not grow beyond an embryonic stage (also known as metastable pits) do not adversely 

affect the performance of engineering structures. In the literature, it has been shown that Erp is the potential 

below which stable pitting or crevice corrosion does not occur, and it is relative insensitive to prior pit depth or 

surface finish. 

The Erp can be compared to the corrosion potential (Ecorr) in the same environment to determine the alloy’s 

susceptibility to localized corrosion. If the Erp is more anodic (noble) than Ecorr, then an alloy will tend to resist 

pitting. If Ecorr is more anodic, then any pits that form will tend to remain active and propagate. 

An additional plot is provided in OLI Studio: Corrosion Analyzer where the corrosion potential and repassivation 

potential both included. The figure below shows an example for 316 stainless steel. Here the level of oxygen 

has been varied to show the change in corrosion potential. At low levels of oxygen, alloy 316 will have a 

tendency to pit readily in brackish waters. 

 

Repassivation and Corrosion Potential for 316 stainless steel in brackish water at various levels or aeration. 

Peak Current 

The peak current is defined by OLI as the current density in the most active pit. It is added as an additional line 

to the polarization curve. The line represents the reverse sweep in a potentiodynamic polarization experiment 

after pit initiation has taken place. OLI does not predict the pitting potential as it is usually a function of the 

history of the metal surface and is therefore variable. 
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Figure 20 shows the peak current for active pits superimposed on the general corrosion polarization curve. 

 

Figure 7. General corrosion polarization curve and peak current for active pits on 316 stainless in aerated sea water at 
15°C under pipe flow at 2 m/s. 

Limitations 

There are some phenomena that are not included in the corrosion rates code. 

• Mixed solvents. The OLI Studio: Corrosion Analyzer only works in the aqueous framework. Therefore 

corrosion in concentrated sulfuric acid, alcohols, etc. cannot be predicted. 

• Shear removal of films, often the cause of erosion-corrosion is not included in the model. 

• Thin films not treated completely. The reduced transport length and gas/liquid equilibrium not entirely 

handled. One could still use Corrosion Analyzer to get ballpark figures for wetted surfaces. 
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General Corrosion Rate and Propensity to Localized Corrosion 

Corrosion in a Sea Water Environment 

Metals used for handling sea water face both general and localized (pitting) corrosion. Various grades of 

stainless steels have been used to try to mitigate the problem. Stainless steels owe their corrosion resistance 

to a thin, adherent film of oxides on their surface. Interruption of the film can lead to localized corrosion (pitting) 

and premature failure. We will look at 304, 316L and S31254 (254 SMO) stainless steels and evaluate its 

performance in sea water as the oxygen content varies. 

Starting the Simulation 

✓ To start the software, double-click the OLI Studio icon on the desktop , which will take you to the OLI 

Studio interface where you can start creating your calculations. 

For this simulation we are learning how to enter a water analysis 

✓ Add a new Water Analysis by clicking on the Add Water Analysis icon or go to the menu bar and 

select Streams > Add New Analysis 

✓ Click on the new Stream and press <F2> to change the name to Sea Water 

✓ Select the AQ thermodynamic Framework 

✓ Enter the composition, temperature and pressure of the stream given in the table below 
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✓ Click on the Add Reconciliation button 

✓ Select the No reconcile option and click on the calculate button 

 

✓ Go to the reconciled stream and right click on it, then select Add as Stream option 

 

✓ A new window opens. Change the name to Molecular Sea Water, leave the default selections and click 

OK 
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A new stream appears in the Navigator Panel 

 

✓ Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add 

Corrosion Rates icon in the Actions Pane. Your screen should look like the image below. 

 

✓ Change the default alloy Carbon steel G10100 (generic) to Stainless Steel 304 
✓ Go to the Survey by option and select survey by Composition 

Your screen should look like the image below 
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At this point, we need to define the variable that we are going to use for the composition survey. In this case 
will be oxygen.  

✓ Under Inflows type O2 

 

✓ Click on the Specs button (as shown in the image below). This will open a new window. Select O2 as 
the component to vary 
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✓ Go to the Survey Range tab and enter the information given in the image below. Then click OK. 
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✓ Click the Calculate button  

Analyzing the Results 

✓ Go to the General Corr. Rate tab 

The default plot looks like the image below 

 

Corrosion rate decreases as the oxygen content increases. The corrosion rate of Stainless Steel 304 is very 

low. From these results, one would think that SS304 would be excellent for sea water applications. At 10 mg/L 

of dissolved oxygen, one would predict 393.5 years of service before 1 mm of metal loss occurs. But that is not 

the case. Type 304 suffers greatly from localized attack in the form of pitting. Let’s analyze the Localized Corr. 

tab.  

✓ Go to the Localized Corr. tab 
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Notice that the software is predicting pitting corrosion at oxygen concentrations above 0.6 mg/L. The reason for 

the failure of SS304 in sea water has to do with the susceptibility of the passive film to be attacked/damaged 

by chlorides. The software is predicting the possible failure of type 304 by predicting the repassivation 

potential within the chemical environment it is exposed to. The repassivation potential is important because it 

indicates whether the metal can passivate its surface again in areas where the protective film has been 

damaged. When the corrosion potential for the surface that is undergoing general corrosion is more negative 

than the repassivation potential, there may be enough driving force to regrow the film; this is the case for oxygen 

concentrations below 0.6 mg/L, where the repassivation potential is above the corrosion potential, and localized 

corrosion is not predicted. Above 0.6 mg/L of oxygen concentration, SS304 suffers localized corrosion because 

the dissolution rate (corrosion potential) is higher than repassivation rate (repassivation potential), and 

hence localized corrosion is favored.  

It is therefore not recommended to use type 304 for sea water applications that exceed 0.6 mg/L of oxygen 

content. 

Why is the corrosion potential increases above a 0.6 mg/L of oxygen content, hence increasing the susceptibility 

to localized corrosion? To further understand this, we can go to the Polarization Curve tab. 

✓ Go to the Polarization Curve tab 
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You will find a default plot shows both the net polarization curve (in red) and the half-reactions that contribute 

to the net polarization curve.  

✓ Click on the variables button. This will open a new window 
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✓ Click on Clear all reactions 

✓ Select the smallest concentration (1-e5 mg/L) of oxygen as shown in the image above 

✓ Let’s add the half reactions of interest. Select the reactions shown in the image below. Click OK. 

 

The polarization curve should look like the image below 

 

Notice that the corrosion potential (located at the red triangle) is  -0.32 V vs SHE, and that the oxygen reduction 

reaction (O2 + 4H(+) = 2H2O – 4e) is not contributing to the net current density. 

✓ Click on the Variables button and add the 10 mg/L O2 curve (as shown below), and click OK 
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Now you will see two overlapped polarization curves. 

 

The new polarization curve (the one located at the top of the graph) now includes the contribution to the oxygen 

reduction reaction (as shown by the blue arrow). The current contribution of this half-reaction changes both the 

total net current response and corrosion potential. The corrosion potential increased to 0.26 V vs SHE. At this 

10 mg/L O2 concentration, the corrosion potential is now higher than the repassivation potential (0.045 V 

vs SHE), hence localized corrosion is predicted.  
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